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Εισαγωγή 

 

Η συλλογή προγραμμάτων AWR Design Environment που συμπεριλαμβάνει το Microwave 

Office, το Analog Office, και το λογισμικό Visual System Simulator είναι ένα πολυδύναμο και 

ολοκληρωμένο εργαλείο σχεδιασμού και ανάλυσης για επικοινωνίες RF, μικροκύματα, 

αναλογικές και σχεδιασμών ολοκληρωμένων κυκλωμάτων (RFIC) που επιτρέπει να 

ενσωματώσεις κυκλωματικά σχέδια σε συτημικό σχεδιασμό χωρίς αλλαγή περιβάλλοντος 

(AWRDE). 

 

Το Microwave Office (MWO) και το Analog Office (AO) επιτρέπουν τη δημιουργία 

περίπλοκων σχεδίων κυκλωμάτων που αποτελούνται απο γραμμικές, μη γραμμικές και 

ηλεκτρομαγνητικές διατάξεις. Η ανάλυση μπορεί να γίνεται με γραμμικά ή μη γραμμικά 

μέσα, σειρές Volterra, βοηθητικά εργαλεία όπως APLAC, Analyst και HSPICE. 

 

Το Visual System Simulator (VSS) είναι το εργαλείο σχεδιασμού σε συστεμικό επίπεδο. 

Μπορεί να χρησιμοποιηθεί για ανάλυση ενός πλήρους επικοινωνιακού συστήματος από 

κωδικοποίηση πηγής μέχρι μετάδοση, λήψη και αποκωδικοποίηση. 

 

Παρακάτω, υπάρχουν βήματα για τη δημιουργία ενός νέου απλού προγράμματος στο AWR, 

όπως και ασκήσεις για καλύτερη εμπέδωση. 

 

Σκοπός της παρούσας διπλωματικής εργασίας είναι η δημιουργία ενός εργαστηριακού 

οδηγού ο οποίος θα επιτρέπει στους φοιτητές να εξοικειωθούν με το AWR και να μπορούν 

να προσομοιώσουν ένα τηλεπικοινωνιακό σύστημα. 
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Άσκηση 1 -ΓΝΩΡΙΜΙΑ ΜΕ ΤΟ ΠΕΡΙΒΑΛΛΟΝ AWR 

Στόχοι Εργαστηριακής Άσκησης 
Στόχος της παρούσας άσκησης είναι η εξοικείωση των σπουδαστών με το λογισμικό , που 

θα χρειαστεί να χρησιμοποιήσουν στη συνέχεια για πιο εξειδικευμένες εφαρμογές. 

  

Έτσι, στο πρώτο μέρος θα μάθουν πως να χειρίζονται τις στοιχειώδεις λειτουργίες του 

προγράμματος, ενώ στο δεύτερο θα κληθούν να δημιουργήσουν κάτι δικό τους, 

δημιουργώντας τα δικά τους projects. 

Πιο συγκεκριμένα, μετά την εκτέλεση της παρούσης, οι φοιτητές θα πρέπει να: 

• Γνωρίζουν πως να δημιουργήσουν και να αποθηκεύσουν ένα νέο Project. 

• Μπορούν να πλοηγηθούν στις εργαλειοθήκες και να χρησιμοποιήσουν τα στοιχεία 

που διατίθενται. 

• Παραμετροποιήσουν διάφορες μεταβλητές του περιβάλλοντος προσομοίωσης (π.χ. 

μονάδες μέτρησης , επιλογή συχνότητας κτλ.). 

• Εξάγουν γραφικές παραστάσεις από τις κυματομορφές που παράγονται. 

Τι θα χρειαστεί 
Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

• Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

Περιβάλλον Εργασίας AWR 
Στην Εικόνα 1 φαίνεται το 

περιβάλλον εργασίας του 

λογισμικού AWR. Ξεκινώντας 

το λογισμικό AWRDE 

φορτώνεται ένα 

προκαθορισμένο κένο Project 

(Untitled Project). Μόνο ένα 

project μπορεί να είναι ενεργό 

κάθε φορά. 

 

 

Εικόνα 1– Περιβάλλον 

εργασίας του λογισμικού AWR 

Design Environment 

 

 

Το περιβάλλον του λογισμικού AWR DE αποτελείται από παράθυρα, διάφορα μενού και 

εργαλειοθήκες, τον πλοηγό Project και τις βιβλιοθήκες δομικών ηλεκτρονικών στοιχείων και 

κυκλωμάτων ώστε να καθιστά εύκολη και φιλική προς τον χρήστη την προσομοίωση και 

μοντελοποίηση επικοινωνιακών συστημάτων. 
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Στην Εικόνα 2 βλέπουμε τα διάφορα συστατικά που δομούν το περιβάλλον εργασίας. 

1. Title bar 

2. Menu bar 

3. Toolbar 

4. Project Browser 

5. System diagrams 

6. Circuit schematics 

7. Workspace 

8. Status Window 

9. Tabs 

 

 

 

Εικόνα 2 - Συνθετικά μέρη του 

περιβάλλοντος εργασίας 

 

Εισαγωγικές Παρατηρήσεις 
Ο σκοπός ενός τηλεπικοινωνιακού συστήµατος είναι η µεταφορά πληροφορίας µε τη 

µορφή σήµατος µέσω ενός καναλιού το οποίο χωρίζει τον ποµπό από τον δέκτη. Το κανάλι 

µπορεί να είναι είτε κάποια µορφή ενσύρµατου µέσου (καλώδιο – οµοαξονικό, οπτική ίνα, 

κτλ…) είτε ο ελεύθερος χώρος που χωρίζει τις 2 κεραίες. Το σήµα µπορεί να είναι είτε 

αναλογικό, είτε ψηφιακό (ψηφιακό µπορεί να γίνει και κάθε αναλογικό σήµα µε την 

κατάλληλη κωδικοποίηση µέσω διαδικασιών δειγµατοληψίας). Παρά το γεγονός ότι είναι 

τεχνικά δυνατό να γίνει η µεταφορά όλων των σηµάτων µέσω ψηφιακού σήµατος, 

υπάρχουν και χρησιµοποιούνται σήµερα πολλές εφαρµογές που χρησιµοποιούν αναλογικές 

εκποµπές (π.χ. ραδιοφωνικό και τηλεοπτικό σήµα). 

 

Στις τηλεπικοινωνίες διαμόρφωση ονομάζεται η διαδικασία μεταβολής ενός περιοδικού 

σήματος, συνήθως υψίσυχνου, με στόχο την κωδικοποίηση σε αυτό ενός σήματος χαμηλής 

συχνότητας το οποίο μεταφέρει κωδικοποιημένη πληροφορία. Το υψίσυχνο σήμα τότε 

καλείται φέρον και συνήθως είναι σήμα απλής συχνότητας (π.χ. μία ημιτονοειδής 

κυματομορφή). Η διαμόρφωση απαιτείται για να μπορέσει να διέλθει ένα σήμα από κάποιο 

τηλεπικοινωνιακό κανάλι (ένα καλώδιο, στις ενσύρματες επικοινωνίες, ή ο ελεύθερος 

χώρος, στις ασύρματες επικοινωνίες) το εύρος ζώνης του οποίου δεν επικαλύπτεται με το 

εύρος ζώνης του σήματος. Στο άλλο άκρο της επικοινωνίας, στον παραλήπτη, λαμβάνει 

χώρα η ανάστροφη διαδικασία προκειμένου να ανακτηθεί το αρχικό σήμα, η 

αποδιαμόρφωση. 

 

Οπότε η µετατροπή του σήµατος της πηγής σε σήµα το οποίο είναι κατάλληλο για 

µετάδοση από το χρησιµοποιούµενο µέσο λέγεται διαµόρφωση (modulation). Η 

αντίστροφη διαδικασία στο δέκτη για τη µετατροπή του λαµβανόµενου σήµατος στο 

βασικό σήµα ονοµάζεται αποδιαµόρφωση (demodulation). 

Στις αναλογικές διαμορφώσεις το σήμα πληροφορίας που διαμορφώνεται είναι σε 

αναλογική μορφή. Οι κυριότερες μέθοδοι των αναλογικών διαμορφώσεων είναι οι: 

Διαμόρφωση πλάτους (AM) 

• Διαμόρφωση απλής ζώνης (SSB) 

• Διαμόρφωση διπλής ζώνης (DSB) 
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Για την εξοικείωση με το περιβάλλον εργασίας θα χρησιμοποιήσουμε ένα παράδειγμα 

προσομοίωσης της Διαμόρφωσης Πλάτους (Amplitude Modulation – AM). 

 

Η διαμόρφωση Πλάτους (ΑΜ - Amplitude Modulation) είναι μία αναλογική διαμόρφωση 

σήματος. Στην διαμόρφωση AM μεταβάλλεται το πλάτος του υψίσυχνου φέροντος κύματος 

ανάλογα με το πλάτος του σήματος πληροφορίας (ακουστικού σήματος). Το διαμορφωμένο 

σήμα ΑΜ που προκύπτει έχει σταθερή συχνότητα και μεταβαλλόμενο πλάτος. 

 

Σκοπό της εργαστηριακής άσκησης αποτελεί η μελέτη των βασικών αρχών της κλασικής 

διαμόρφωσης πλάτους (AM-Amplitude Modulation). Τα χαρακτηριστικά και οι ιδιότητες 

της, θα μελετηθούν με την βοήθεια εργαλείων προσομοίωσης σε επίπεδο συστήματος, που 

προσφέρει το AWR. Θα μελετηθεί η επίδραση των παραμέτρων της διαμόρφωσης τόσο 

στην χρονική εικόνα του σήματος όσο και στο φάσμα του. Επιπλέον, στόχο αποτελεί η 

εξοικείωση στην σχεδίαση συστημάτων με διαμορφώσεις πλάτους. 

Πείραμα: Διαμόρφωση Πλάτους (Amplitude Modulation 
– AM) 
 

Σε αυτό το παράδειγμα ένα ημιτονοειδές σήμα συχνότητας 1GHz διαμορφώνεται από έναν 

ημιτονικό φορέα συχνότητας 10 GHz.  

H διαμόρφωση AM περιγράφεται μαθηματικά ως: 

 

όπου m(t) είναι το πληροφοριακό σήμα βασικής ζώνης, δηλαδή το σήμα που 

μεταφέρει την χρήσιμη πληροφορία. Στο συγκεκριμένο παράδειγμα θα 

χρησιμοποιήσουμε ένα απλό ημιτονοειδές σήμα συχνότητας 2 GHz, το οποίο 

μαθηματικά περιγράφεται από τη σχέση: 

 

To Α αναπαριστά τη συνεχή συνιστώσα (DC offset) του διαμορφωμένου σήματος, 

ενώ το Β και το C αναπαριστούν το πλάτος του πληροφοριακού σήματος και του 

φορέα, αντίστοιχα.  

Εργαστηριακή διαδικασία 
Οι δραστηριότητες στο παρόν παράδειγμα περιλαμβάνουν:  

1. Τη δημιουργία ενός νέου έργου (Project) . 

2. Τον ορισμό προκαθορισμένων ρυθμίσεων συστήματος . 

3. Τη δημιουργία ενός διαγράμματος συστήματος (system block) . 

4. Την προσθήκη ηλεκτρονικών στοιχείων (blocks) στο διάγραμμα συστήματος . 

5. Τον ορισμό των παραμέτρων προσομοίωσης . 

6. Την προσθήκη γραφημάτων και μετρήσεων . 

7. Την εκτέλεση της προσομοίωσης και την ανάλυση των αποτελεσμάτων . 
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Δημιουργία Project 
Επιλέγουμε File > Save Project As. Το 

παράθυρο διαλόγου Save As εμφανίζεται  

Επιλέγουμε τον φάκελο στον οποίο θέλουμε 

να αποθηκεύσουμε το Project.  

Δίνουμε μία ονομασία της επιλογής μας, π.χ. 

“AM” το νέο Project, στο παράθυρο 

διαλόγου που εμφανίζεται. Αποθηκεύουμε 

πατώντας Save.  

 

Σημείωση: Συνίσταται να αποθηκεύουμε 

κάθε νέο Project σε ξεχωριστό φάκελο. 

 

Ρύθμιση των καθολικών ρυθμίσεων και δημιουργία διαγράμματος 

συστήματος. 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του 

συστήματος. Για να τις ορίσουμε κάνουμε τα εξής βήματα: 

• Από το οριζόντιο μενού επιλέγουμε Option > Project Options 

• Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις 

αντιστοιχούν με αυτές που δίνονται στην Εικόνα 3. 

• Πατάμε OK για να αποθηκεύσουμε τις ρυθμίσεις 

 

 
Εικόνα 3 – Ορισμός προκαθορισμένων ρυθμίσεων συστήματος 
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Δημιουργία Διαγράμματος Συστήματος  
Το διάγραμμα συστήματος είναι το πλέον βασικό τμήμα του περιβάλλοντος εργασίας, 

καθώς αποτελεί τον καμβά στον οποίο χτίζουμε εξ’ ολοκλήρου (end-to-end) τα συστήματα 

επικοινωνιών και υλοποιούμε αλγορίθμους με γραφικό τρόπο χρησιμοποιώντας τα block 

συμπεριφοράς (behavioral blocks) του VSS. Ένα VSS project μπορεί να περιλαμβάνει 

πολλαπλά διαγράμματα συστήματος, γραμμικά και μη-γραμμικά σχηματικά, και netlists. 

Για τη δημουργία διαγράμματος  συστήματος υπάρχουν δύο τρόποι. 

 

1. Επιλογή του Add New System Diagram 

 

 

 
2. Επιλέγουμε Project > 

Add System Diagram > 

New System Diagram. 

Εμφανίζεται το 

παράθυρο διαλόγου του 

νέου διαγράμματος 

συστήματος.  

Πληκτρολογούμε “AM” και 

πατάμε Create.  

 

 

Ένα παράθυρο διαγράμματος 

συστήματος εμφανίζεται στον 

χώρο εργασίας (workspace) και 

το “AM” διάγραμμα συστήματος 

εμφανίζεται κάτω από τα 

System Diagrams στον πλοηγό 

Project.  

 

 

Εικόνα 4 – Διάγραμμα 

Συστήματος 
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Προσθήκη Block στο διάγραμμα συστήματος 
Ο κατάλογος στοιχείων (elements catalog) είναι μία βάση που περιέχει πολλά δομικά μπλοκ 

(ηλεκτρικά/ ηλεκτρονικά στοιχεία), τα οποία μπορούν να χρησιμοποιηθούν στα 

διαγράμματα συστήματος ώστε να συνθέσουμε ένα σύστημα ή έναν αλγόριθμο 

επικοινωνίας.  

Για να τοποθετήσουμε ένα μπλοκ στο διάγραμμα συστήματος ακολουθούμε τα εξής 

βήματα:  

1. Πατάμε στην καρτέλα Elements (κάτω αριστερά) ώστε να εμφανιστεί ο 
κατάλογος στοιχείων.  

2. Πατάμε στο σύμβολο + αριστερά του System Block για να επεκτείνουμε το δέντρο 

του καταλόγου.  

3. Επιλέγουμε την κατηγορία Sources. Και από τα Waveforms επιλέγουμε το 

Sine(Εικόνα 5) και το σύρουμε (drag ‘n’ drop) στο διάγραμμα συστήματος .Στο 

τρίγωνο πατάμε και επιλέγουμε Real Data όπως φένεται εικόνα 6. 

 
Εικόνα 5– Τοποθέτηση του μπλοκ στοιχείου στο διάγραμμα συστήματος 

 
 

Εικόνα 6-Αλλαγή sine  σε Real Data 
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• Επεκτείνουμε την κατηγορία Sources και από την υποκατηγορία Waveforms και 

επιλέγουμε άλλο ένα Sine block και το τοποθετούμε στο διάγραμμα συστήματος όπως 

φαίνεται στην Εικόνα 7.  

 

 
 

Εικόνα 7 – Τοποθέτηση του Sine Block στο διάγραμμα συστήματος 

 

 

• Επεκτείνουμε την κατηγορία Modulation, επιλέγουμε την υποκατηγορία Analog. 

Επιλέγουμε το AM_MOD block και το προσθέτουμε στο διάγραμμα συστήματος.  

• Επεκτείνουμε την κατηγορία Converters, επιλέγουμε την υποκατηγορία Complex 

Envelope. Επιλέγουμε το CE2R block και το προσθέτουμε στο διάγραμμα 

συστήματος.  

• Πάμε File > Save Project.  

 

 
To διάγραμμα συστήματος πρέπει να φαίνεται όπως στην Εικόνα 9, χωρίς όμως τις 

διασυνδέσεις μεταξύ των μπλοκ, τις οποίες θα τοποθετήσουμε στη συνέχεια. 

 

Διασύνδεση των Μπλοκ Στοιχείων και Προσθήκη Σημείων Ελέγχου 
Για να διασυνδέσουμε μεταξύ τους τα μπλοκ στοιχεία του διαγράμματος, ώστε να 

δημιουργήσουμε ένα συνεκτικό διάγραμμα συστήματος ακολουθούμε τα εξής βήματα: 

• Τοποθετούμε τον δρομέα (cursor) στη διεπαφή του μπλοκ στοιχείου (Εικόνα 8). 

Εμφανίζεται ένα καλώδιο. 

• Κάνουμε Click και κρατώντας πατημένο το πλήκτρο στο ποντίκι σέρνουμε και 

διασυνδέουμε κατάλληλα στην διεπαφή ενός άλλου μπλοκ στοιχείου. 
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Εικόνα 8 – Σύνδεση στοιχείου 

 

• Διασυνδέουμε όλα τα μπλοκ στοιχεία του διαγράμματος συστήματος όπως 

φαίνεται στην Εικόνα 9: 

 

Εικόνα 9 – Διασύνδεση των μπλοκ στοιχείων- Προσθήκη Test Points 

 
• Για να τοποθετήσουμε σημεία ελέγχου (Test Points TP) σε επιλεγμένα σημεία του 

διαγράμματος, πάμε στην κατηγορία Meters. Επιλέγουμε και προσθέτουμε στο 

διάγραμμα συστήματος τρία σημεία ελέγχου, όπως φαίνονται στην Εικόνα 9. 

 

Προσοχή: Σε κάθε μπλοκ στοιχείο μέτρησης παρατηρούμε έναν αριθμό ID. Π.χ. ID = TP1 ID = 

TP2 κτλ. Θα πρέπει να τα τοποθετήσουμε με την σειρά που φαίνεται στην εικόνα, διότι 

αυτά τα ID αποτελούν παράμετρο στη δημιουργία των γραφημάτων αργότερα. 
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Ορισμός Παραμέτρων των Μπλοκ Στοιχείων  
Για να παραμετροποιήσουμε τις επιλογές των μπλοκ στοιχείων του διαγράμματος 

συστήματος, ακολουθούμε τα παρακάτω βήματα:  

1. Στο διάγραμμα συστήματος κάνουμε διπλό click στο Sine Block . Οι επιλογές του 

στοιχείου εμφανίζονται στην Εικόνα 10.  

 

 
Εικόνα 10 – Ιδιότητες ημιτονοειδούς πηγής 

 

2. Πατάμε στο Show Secondary για να εμφανιστούν και οι δευτερεύουσες παράμετροι του 

στοιχείου. Επεξεργαζόμαστε τις παραμέτρους όπως φαίνεται στην Εικόνα 10.  

4. Κάνουμε διπλό click στο SINE που είναι το φέρον μας  και αλλάζουμε την τιμή της 

παραμέτρου FRQ σε “10”. Πατάμε ΟΚ.  

5. Κάνουμε διπλό click στο AM_MOD μπλοκ και θέτουμε την τιμή της παραμέτρου MODIDX 

σε “1”. Πατάμε OK.  

 
Οι τιμές που ορίσαμε στο παράθυρο διαλόγου της ημιτονοειδούς πηγής πρέπει να 

συμφωνούν με αυτές τις Εικόνας 10. 

 

Σημείωση: Μπορούμε να τροποποιήσουμε απευθείας τις παραμέτρους των μπλοκ 

στοιχείων από τη λίστα που εμφανίζεται άνωθεν του κάθε στοιχείου, κάνοντας click στην 

τιμή της κάθε παράμετρου. 

 

Ορισμός των Παραμέτρων Προσομοίωσης 
Για να ορίσουμε τις παραμέτρους προσομοίωσης κάνουμε τα παρακάτω βήματα: 

1. Επιλέγουμε Options > Default System Options. Το παράθυρο διαλόγου των παραμέτρων 

προσομοίωσης εμφανίζεται. 

2. Πάμε στην καρτέλα Simulator και κάτω από το Sampling Frequencies / Data Rates 

επιλέγουμε Data rate στο πρώτο drop-down μενού και Oversampling στο δεύτερο drop-

down μενού. 

3. Θέτουμε “1” GHz το Data rate και 160 την τιμή του Oversampling (Εικόνα 11). Πατάμε OK. 
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Εικόνα 11 – Ιδιότητες προσομοιωτή συστήματος 

Δημιουργία Γραφήματος  
O VSS επιτρέπει να δούμε τα αποτελέσματα μιας 

προσομοίωσης με διάφορα γραφήματα. Πριν 

εκτελέσουμε μια προσομοίωση πρέπει να 

δημιουργήσουμε ένα γράφημα και να καθορίσουμε τα 

δεδομένα και τις παραμέτρους που επιθυμούμε να 

απεικονίσουμε.  

Για να δημιουργήσουμε ένα γράφημα κάνουμε τα 

ακόλουθα βήματα:  

1. Πάμε στην καρτέλα Project (κάτω αριστερά), ώστε να 

εμφανίσουμε τον πλοηγό Project.  

2. Κάνουμε δεξί click στην κατηγορία Graphs και 

επιλέγουμε New Graph. Το παράθυρο διαλόγου New 

Graph εμφανίζεται. Δίνουμε όνομα της επιλογής μας, 

π.χ. “Amplitude Modulation”, επιλέγουμε Rectangular 

σαν τύπο γραφήματος και πατάμε Create.  

3. Το γράφημα εμφανίζεται στον χώρο εργασίας και σαν 

καταχώρηση κάτω από την κατηγορία Graphs στον 

πλοηγό Project (Εικόνα 12).  

 

 

Εικόνα 12 – Προσθήκη νέου γραφήματος 

 

Προσθήκη Μέτρησης 
Για να προσθέσουμε μια μέτρηση στο γράφημα που δημιουργήσαμε ακολουθούμε τα 

παρακάτω βήματα: 
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1. Κάνουμε δεξί click στο γράφημα “Amplitude Mod” στον πλοηγό Project, και 

επιλέγουμε Add Measurement. Το παράθυρο διαλόγου του Add Measurement 

εμφανίζεται (Εικόνα 13). 

 

 

Εικόνα 13 – Προσθήκη μέτρησης σε γράφημα 

2. Για τον τύπο της μέτρησης επιλέγουμε System και για την μέτρηση επιλέγουμε WVFM. 

3. Θέτουμε την τιμή “10” στο πεδίο Time Span και επιλέγουμε ns (nanosecond) σαν την 

μονάδα μέτρησης. 

4. Επιλέγουμε Real σαν Complex Modifier. 

5. Επιβεβαιώνουμε ότι το Test Point έχει οριστεί ως TP.TP1, και πατάμε Apply. Η μέτρηση 

AM:Re(WVFM(TP.TP1,10,5,1,0,0,0,0,0)) έχει εισαχθεί κάτω από το γράφημα “Amplitude 

Mod” στον πλοηγό Project. 

6. Επιλέγουμε στο Test Point TP.TP2 και πατάμε Apply.  

 

Στον πλοηγό Project μπορούμε να δούμε ότι οι μετρήσεις έχουν προστεθεί στο γράφημα 

(Εικόνα 14). 
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Εικόνα 14 – Μετρήσεις που έχουν εισαχθεί στο γράφημα 

Εκτέλεση Προσομοίωσης 
Μετά την επιτυχή υλοποίηση όλων των παραπάνω βημάτων, είμαστε πλέον έτοιμοι να 

θέσουμε σε λειτουργία την προσομοίωση του συστήματος. Για το σκοπό αυτό επιλέγουμε: 

Simulate > Run/Stop System Simulators. Αφήνουμε την προσομοίωση να τρέξει για 5 

δευτερόλεπτα και στη συνέχεια την διακόπτουμε με την επιλογή Simulate > Run/Stop 

Simulators. Το αποτέλεσμα της προσομοίωσης πρέπει να φαίνεται στο γράφημα όπως στην 

Εικόνα 15. 

 

Εικόνα 15 – Αποτέλεσμα προσομοίωσης 
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Λίστα Ελέγχου Γνώσεων 
1. Βεβαιωθείτε ότι έχετε κατανοήσει πως δημιουργούμε και αποθηκεύουμε ένα νέο 

Project.  

2. Bεβαιωθείτε ότι γνωρίζετε πως να πλοηγηθείτε στην βιβλιοθήκη block στοιχείων 

του AWR και να εντοπίσετε διάφορα κυκλώματα, π.χ. γεννήτριες σημάτων, 

διαμορφωτές, πηγές τάσεως κτλ.  

3. Βεβαιωθείτε ότι μπορείτε να απεικονίσετε κυμματομορφές σε διάφορα σημεία του 

κυκλώματος.  

4. Βεβαιωθείτε ότι έχετε κατανοήσει τη σημασία των καθολικών παραμέτρων του 

συστήματος και πως αυτές επιδρούν στα αποτελέσματα της προσομοίωσης.  

 

ΔραστηριότητεςΔραστηριότητεςΔραστηριότητεςΔραστηριότητες    

Απλές Δραστηριότητες 
Το περιβάλλον του AWR διαθέτει μια πληθώρα συντομεύσεων για διάφορες λειτουργίες. 

Για παράδειγμα για να ξεκινήσουμε την προσομοίωση ενός συστήματος μπορούμε να πάμε 

από το μενού σε Simulate > Run/Stop Simulators, όμως μπορούμε επίσης να εκτελέσουμε 

την προσομοίωση από το πλήκτρο στην εργαλειοθήκη όπως φαίνεται στην εικόνα 17. 

Επισης για να αναζητήσουμε κάποιο ELEMENT μπορούμε παλι απο την εργαλειοθήκη όπως 

φένεται παρακάτω. 

 

 

Εικόνα 17 – Συντόμευση εκτέλεσης προσομοίωσης 

1. Καλείστε να μελετήσετε το γραφικό περιβάλλον και να εντοπίσετε τις διάφορες 

συντομεύσεις εκτελώντας ξανά το πείραμα της διαμορφώσεως AM. 

2. Στο διαμορφωτή AM_MOD αλλάξτε τη τιμή του MODIDX(ποσοστό διαμόρφωσης) 

για περίπτωση <1, =1, >1. Τί παρατηρείται ; 

Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη -Χρήσιμοι 
σύνδεσμοι 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• Freznel L. E. (1999), Ηλεκτρονικές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Hsu H. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Σηµειώσεις Μαθήµατος Τηλεπικοινωνιών I, Ζαρούχας Θωμάς, Τσακανίκας 

Βασίλειος και Παρασκευάς Μιχάλης. 

• Εισαγωγή στα τηλεπικοινωνιακά συστήματα, Γ. Κοκκινάκης, 2004 
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Άσκηση  2-  AM-DSB ΔΙΑΜΟΡΦΩΣΗ 

(Διπλοπλευρική διαμόρφωση) 

AM-DSB διαμόρφωση - Στόχοι Εργαστηριακής Άσκησης 
Σκοπός τη άσκησης είναι να εξοικειωθούν οι σπουδαστές με την προσομοίωση 

διαμόρφωσης AM-DSB ακουστικού σήματος , έτσι ώστε να μελετηθεί η διαμόρφωση 

πλάτους διπλής ζώνης. 

Προσδοκώμενα αποτελέσματα 
Πιο συγκεκριμένα, μετά την εκτέλεση της παρούσης εργαστηριακής άσκησης οι φοιτητές θα 

πρέπει να: 

• Περιγράφουν την έννοια της διαμόρφωσης . 

• Να απεικονίζουν τα σήματα στο πεδίο του χρόνου  και στο πεδίο της συχνότητας. 

• Χρησιμοποιούν το AWR για τη προσομοίωση των διαφόρων τεχνικών διαμόρφωσης 

πλάτους. 

• Παραμετροποιήσουν διάφορες μεταβλητές του περιβάλλοντος προσομοίωσης (π.χ. 

μονάδες μέτρησης κτλ.). 

• Εξάγουν γραφικές παραστάσεις από τις κυματομορφές που παράγονται. 

Τι θα χρειαστεί 
Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

• Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

Έννοιες κλειδιά 
• Αναλογική Διαμόρφωση 

• Διαμόρφωση κατά πλάτος 

• Σήμα 

• Συχνότητα 

 

Εισαγωγικές  Παρατηρήσεις 
Η σπατάλη ενέργειας κατά τη διαµόρφωση ΑΜ που είδαµε, λόγω µεταφοράς του φορέα 

µαζί µε την ωφέλιµη πληροφορία των πλευρικών συχνοτήτων, οδηγεί στη σκέψη 

αποµάκρυνσης του φορέα κατά τη διαµόρφωση.  

Αυτό µπορεί να επιτευχθεί αν πολλαπλασιάσουµε το σήµα m(t) µε το φορέα 

 c(t) = Acos(2πfct). 

Άρα στο DSB-SC έχουµε: u(t)=Am(t)cos2πfct. 

Στο πεδίο της συχνότητας αν Μ(f) είναι ο µετασχηµατισµός Fourier της m(t), 

τότε U(f)= ½ [M(f-fc)+M(f+fc)]. 
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Παρατηρούµε ότι το σήµα βασικής ζώνης µετατοπίζεται στις θέσεις +fc,-fc, δεν εµφανίζεται 

όµως ξεχωριστά το φέρον σήµα όπως στην απλή διαµόρφωση ΑΜ. Η αποδιαµόρφωση 

πραγµατοποιείται πολλαπλασιάζοντας το διαµορφωµένο σήµα πάλι µε cos2πfct, οπότε 

προκύπτει το σήµα 

m(t)(cos^2)2πfct. Στο πεδίο της συχνότητας έχουµε: 
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Παρατηρούµε ότι το φάσµα µετατέθηκε στη θέση f=0, µε πλάτος ½  Μ(0) και επίσης στις 

θέσεις 2fc,-2fc µε πλάτος ¼ Μ(0). Με τη βοήθεια ενός κατωδιαβατού φίλτρου εύκολα 

λαµβάνεται το φάσµα M(f), ενώ αποκόπτονται τα υπόλοιπα. 

 

Ο πολλαπλασιασµός στο δέκτη µε ένα σήµα cos2πfct προκειµένου να επιτευχθεί 

αποδιαµόρφωση του σήµατος βασικής ζώνης προϋποθέτει τη δηµιουργία στο δέκτη ενός 

σήµατος µε συχνότητα και φάση ίση µε αυτή του φέροντος σήµατος που έχει 

δηµιουργηθεί στον ποµπό. Αν ένα από τα δύο έχει απόκλιση από τα αντίστοιχα του 

φέροντος σήµατος τότε προκαλείται παραµόρφωση του σήµατος. 

 

Ένας τρόπος για να εξασφαλισθεί η πιστότητα συχνότητας και φάσης µεταξύ των 

σηµάτων στον ποµπό και το δέκτη σε συστήµατα µε κατεσταλμένο φέρον, είναι η 

µετάδοση µαζί µε το ωφέλιµου σήµα ενός µικρού ποσοστού του φέροντος κύµατος που 

ονοµάζεται πιλότος (ή τόνος πιλότος). Στο δέκτη ο πιλότος διαχωρίζεται µε ένα φίλτρο 

στενής ζώνης, ενισχύεται και «κλειδώνει» τη φάση ενός τοπικού ταλαντωτή που παράγει το 

φορέα. Μία εναλλακτική µέθοδος επίλυσης του προβλήµατος είναι να δηµιουργήσουµε 

από το λαµβανόµενο σήµα ένα ηµιτονοειδές φέρον µε κλειδωµένη φάση, µε τη βοήθεια 

ενός βρόχου κλειδώµατος φάσης (phase locked loop – PLL). 

 

Πείραμα: ΔΙΑΜΟΡΦΩΣΗ AM-DSB 
Σε αυτό το πείραμα φτιάχνουμε και κάνουμε εξομοίωση μιας διαμόρφωσης AM-DSB για τη 

μελέτη και την εξοικείωση με την τεχνική διαμόρφωσης πλάτους διπλής ζώνης. Δηλαδή τη 

πραγματοποίηση του κυκλώματος με την μορφή δομικού διαγράμματος, με σκοπό την 

παρατήρηση της συμπεριφοράς του σήματος (πληροφορία) τόσο στο πεδίο του χρόνου, 

όσο και στο πεδίο των συχνοτήτων (φάσμα). 

 

Το πρόγραμμα στο τέλος θα χρησιμοποιεί: 

• Ένα σήμα πληροφορίας (στην προκειμένη περίπτωση 1 ημίτονο).  

• Ένα ημιτονικό σήμα ώς φέρον. 

• Έναν πολλαπλασιαστή (Product) . 

 

Οι διαδικασίες σε αυτό το παράδειγμα περιλαμβάνουν:  

• Έλεγχο της κυματομορφής του σήματος της πληροφορίας τόσο πριν 

πολλαπλασιαστεί με το φέρον, μετά τον πολλαπλασιασμό (δηλαδή μετά την 

διαμόρφωση), πάλι χρονικά και συχνοτικά. 

• Ρύθμιση του πλάτους με σκοπό την παρατήρηση στην αλλαγή του σήματος τόσο 

στο πλάτος αλλά και στην ισχύ στην οποία θα χρειαστεί να μεταδοθεί. 

Δημιουργία Project 
Βήμα 1

ο
:Πάμε στο File>New Project 

Βήμα 2ο:Επιλέγουμε File > Save Project As. Το παράθυρο διαλόγου Save As εμφανίζεται. 

Βήμα 3ο:Επιλέγουμε τον φάκελο στον οποίο θέλουμε να αποθηκεύσουμε το Project. 

Βήμα 4ο:Δίνουμε μία ονομασία της επιλογής μας, π.χ. “DSB MOD” το νέο Project, στο 

παράθυρο διαλόγου που εμφανίζεται. Αποθηκεύουμε πατώντας Save. 

Σημείωση: Συνίσταται να αποθηκεύουμε κάθε νέο Project σε ξεχωριστό φάκελο. 

 



Τηλεπικοινωνιακά Συστήματα Ι                             Εργαστηριακός Οδηγός                                                 Διπλωματική Εργασία 

 

24 

 

Ρύθμιση των καθολικών ρυθμίσεων και δημιουργία διαγράμματος 

συστήματος. 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του 

συστήματος. Για να  τις ορίσουμε κάνουμε τα εξής βήματα: 

• Από το οριζόντιο μενού επιλέγουμε Options> Project Options 

• Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις 

αντιστοιχούν με αυτές που δίνονται παρακάτω 

• Πατάμε ΟΚ για να αποθηκεύσουμε τις ρυθμίσεις. 

 

Δημιουργία Διαγράμματος Συστήματος 

• Στο μενού Project, κάτω από την επιλογή Add System Diagram, επιλέγουμε την επιλογή 

New System Diagram όπως φαίνεται στο σχήμα.  

 

• Πληκτρολογούμε "DSB " ή “DSB MOD”στο πεδίο κειμένου κι πατάμε το κουμπί 

«Create» ακριβώς από κάτω. 
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• Πηγαίνουμε στο Elements tab που βρίσκεται στα αριστερά. 

 

• Αφού αναπτύξουμε το Systems blocks, στην κατηγορία Sources επιλέγουμε όπως 

φαίνεται με κόκκινο στο παρακάτω σχήμα την υπο-ομαδα Waveforms. Στη συνέχεια 

επιλέγουμε το στοιχείο SINE και το τοποθετούμε στο διάγραμμα, σύροντάς το, όπως 

φαίνεται παρακάτω και κάνοντας διπλό κλικ στο τριγωνάκι επιλέγουμε Real Data. 
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• Από την ίδια κατηγορία Sources προσθέτουμε άλλο ένα SINE και το τοποθετούμε στο 

διάγραμμα μας σύροντας το και αυτό χωρίς να αλλάξουμε το τύπο του.  

 

• Στην κατηγορία Math Tools στη συνέχεια,  επιλέγουμε να βάλουμε στο διάγραμμα με 

τον ίδιο τρόπο όπως και παραπάνω το μπλοκ MULT φαίνεται παρακάτω. 

 

 

• Μετά πηγαίνουμε στο toolbar και πιέζουμε το Test Point button (=κουμπί). 

Τοποθετούμε ανάμεσα στα SINE και στο MULT block που έχουμε βάλει στο 

διάγραμμα. Βάζουμε άλλο ένα Test Point με τον ίδιο τρόπο στην έξοδο του MULT 

block. 
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• Συνδέουμε τα blocks και τα test points όπως φαίνεται παρακάτω. Αυτό σημαίνει ότι 

μεταφέρεται σήμα από το ένα block (στοιχείο) στο άλλο. Η σύνδεση στοιχείου με 

στοιχείου γίνεται κάνοντας κλικ στην έξοδο του προηγούμενου και στη συνέχεια κλικ 

στην είσοδο του επόμενου. Ένα στοιχείο μπορεί να δίνει σήμα σε πάνω από ένα 

στοιχεία. 

 

 

• Κάνουμε διπλό click στο SINE block(ID A1) (τα ονόματα φαίνονται στο κείμενο πάνω 

από κάθε στοιχείο). έτσι ώστε να είναι οι ρυθμίσεις , όπως φαίνεται παρακάτω. 

 

 

 

• Κάνουμε διπλό click στο SINE block(ID A2). Βάζουμε ‘’0’’ στο FRQ και ‘’0’’ στο CTRFRQ  

, όπως φαίνεται παρακάτω. 
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• Κάνουμε διπλό click στο MULT block.Βάζουμε ‘’Real domain’’ στο CEMODE και ‘’0’’ 

στο CTRFRQ  , όπως φαίνεται παρακάτω. 

 

1. Στο μενού Options επιλέγουμε Default System Options. Οι παράμετροι πρέπει να 

είναι όπως παρακάτω: 
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2. Στον Project Browser, κάνουμε δεξί click στα Graphs και μετά επιλέγουμε New 

Graph. Πληκτρολογούμε "DSB MOD" σαν όνομα και επιλέγουμε Rectangular σαν 

graph type. Μετά κάνουμε click στο Create. Όλα αυτά φαίνονται παρακάτω. 

 

 

3. Στον Project Browser κάνουμε δεξί click στο "DSB MOD" και επιλέγουμε Add 

Measurement.  
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1. Στο παράθυρο που θα ανοίξει, επιλέγουμε System σαν Measurement Type και WVFM 

σαν Measurement. 

2. Επίσης επιλέγουμε TP.TP1 σαν Test Point, και Time Span = "1". Το Units πρέπει να “ns”. 

Τέλος κάνουμε click στο OK για να αποθηκεύσουμε τις αλλαγές. Τα ίδια κάνουμε και 

για το TP.TP2 και TP.TP3. 
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Σημείωση:Το κύκλωμα είναι έτοιμο για προσομείωση. Η προσομοίωση (για να ληφθεί το 

διάγραμμα) γίνεται πιέζοντας το αντίστοιχο κουμπί στο toolbar, όπως φαίνεται 

παρακάτω. 

 

 

 

Εκτέλεση Προσομοίωσης 
Μετά την επιτυχή υλοποίηση όλων των παραπάνω βημάτων, είμαστε πλέον έτοιμοι να 

θέσουμε σε λειτουργία την προσομοίωση του συστήματος. Για το σκοπό αυτό επιλέγουμε: 

Simulate > Run/Stop System Simulators. Αφήνουμε την προσομοίωση να τρέξει για 5 

δευτερόλεπτα και στη συνέχεια την διακόπτουμε με την επιλογή Simulate > Run/Stop 

Simulators. Το αποτέλεσμα της προσομοίωσης πρέπει να φαίνεται στο γράφημα όπως στην 

Εικόνα παρακάτω. 

 

Εικόνα  – Αποτέλεσμα προσομοίωσης 

Λίστα Ελέγχου Γνώσεων 
1. Βεβαιωθείτε ότι έχετε κατανοήσει τη διαμόρφωση DSB και μπορείτε να εντοπίσετε 

τα διάφορα κυκλώματα. 

2. Βεβαιωθείτε ότι μπορείτε να απεικονίσετε κυμματομορφές σε διάφορα σημεία του 

κυκλώματος.  

3. Βεβαιωθείτε ότι έχετε κατανοήσει τη σημασία των καθολικών παραμέτρων του 

συστήματος και πως αυτές επιδρούν στα αποτελέσματα της προσομοίωσης.  
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Δραστηριότητες 

Απλές Δραστηριότητες 
1. Καλείστε να μελετήσετε το γραφικό περιβάλλον και να εντοπίσετε τις διάφορες 

συντομεύσεις εκτελώντας ξανά το πείραμα της διαμορφώσεως AM-DSB. 

2. Στο πείραμα της διαμορφώσεως AM-DSB απεικονίσαμε 3 κυματομορφές στο ίδιο 

γράφημα. Καλείστε να δημιουργήσετε 3 διαφορετικά γραφήματα στο χώρο 

εργασίας, ένα για κάθε κυματομορφή. 

Προχωρημένες Δραστηριότητες 
1. Στο πείραμα που εκτελέστηκε σε αυτήν την άσκηση προσθέστε ένα επιπλέον 

γράφημα που να απεικονίζει το φάσμα του διαμορφωμένου σήματος. 

New Graph->Add Measurement->Measurement Type επιλογή  Spectrum  όπως 

φένεται παρακάτω. 

 
 

 

 

2. Στο πείραμα που εκτελέστηκε σε αυτήν την άσκηση προσθέστε ένα επιπλέον 

γράφημα που να απεικονίζει την ισχύ του διαμορφωμένου σήματος. 

New Graph->Add Measurement->Measurement Type όπως φένεται παρακάτω. 
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Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη -Χρήσιμοι 
σύνδεσμοι 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• https://awrcorp.com/download/faq/english/docs/Getting_Started/ 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• Freznel L. E. (1999), Ηλεκτρονικές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Hsu H. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Σηµειώσεις Μαθήµατος Τηλεπικοινωνιών I, Ζαρούχας Θωμάς, Τσακανίκας 

Βασίλειος και Παρασκευάς Μιχάλης. 

• Εισαγωγή στα τηλεπικοινωνιακά συστήματα, Γ. Κοκκινάκης, 2004. 
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Άσκηση  3- AM-DSB ΑΠΟΔΙΑΜΟΡΦΩΣΗ 

AM-DSB Αποδιαμόρφωση - Στόχοι Εργαστηριακής 
Άσκησης 
Σκοπός τη άσκησης είναι να εξοικειωθούν οι σπουδαστές με την προσομοίωση 

αποδιαμόρφωσης AM-DSB ακουστικού σήματος , έτσι ώστε παρατηρηθεί το λαμβανόμενο 

σήμα  τόσο χρονικά, όσο και φασματικά. 

Προσδοκώμενα αποτελέσματα 
Πιο συγκεκριμένα, μετά την εκτέλεση της παρούσης εργαστηριακής άσκησης οι φοιτητές θα 

πρέπει να: 

• Περιγράφουν την έννοια της διαμόρφωσης . 

• Να απεικονίζουν τα σήματα στο πεδίο του χρόνου  και στο πεδίο της συχνότητας. 

• Χρησιμοποιούν το AWR για τη προσομοίωση των διαφόρων τεχνικών διαμόρφωσης 

πλάτους 

• Παραμετροποιήσουν διάφορες μεταβλητές του περιβάλλοντος προσομοίωσης (π.χ. 

μονάδες μέτρησης κτλ.). 

• Εξάγουν γραφικές παραστάσεις από τις κυματομορφές που παράγονται. 

Τι θα χρειαστεί 
Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

• Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

Έννοιες κλειδιά 
• Αναλογική Διαμόρφωση 

• Αποδιαμόρφωση κατά πλάτος 

• Σήμα 

• Συχνότητα 

Εισαγωγικές  Παρατηρήσεις 
Η λήψη και η αποδιαμόρφωση ενός σήματος αποτελεί την αντίστροφη διαδικασία της 

διαμόρφωσης και της εκπομπής. Συνεπώς, η τηλεπικοινωνιακή αλυσίδα που περιγράφτηκε 

στις προηγούμενες εργαστηριακές ασκήσεις αντιστρέφεται στην πλευρά του δέκτη μέχρι 

την ανακατασκευή του ακουστικού σήματος. 

Πείραμα: ΑΠΟΔΙΑΜΟΡΦΩΣΗ ΑΜ-DSB  
Σε αυτό το πείραμα φτιάχνουμε και κάνουμε εξομοίωση μια αποδιαμόρφωση  AM-DSB 

αντίστοιχα, με σκοπό την παρατήρηση του λαμβανόμενου σήματος  τόσο χρονικά, όσο και 

φασματικά. 

Το πρόγραμμα στο τέλος θα χρησιμοποιεί: 

• Ένα σήμα πληροφορίας (στην προκειμένη περίπτωση 1 ημίτονο).  

• Ένα ημιτονικό σήμα ώς φέρον. 

• Έναν πολλαπλασιαστή (Product). 

• Ένα lowpass filter (χαμηλοδιαβατό φίλτρο). 
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Οι διαδικασίες σε αυτό το παράδειγμα περιλαμβάνουν:  

• Έλεγχος της κυματομορφής του σήματος της πληροφορίας μετά την διαμόρφωση, 

μετά τον πολλαπλασιασμό πάλι με το φέρον, καθώς και μετά το χαμηλοδιαβατό 

φίλτρο.  

• Ρύθμιση του πλάτους με σκοπό την παρατήρηση στην αλλαγή του σήματος τόσο 

στο πλάτος αλλά και στην ισχύ στην οποία θα χρειαστεί να μεταδοθεί . 

• Παρατήρηση του τι συμβαίνει, με την αλλαγή φάσης στο τελικό σήμα, καθώς και τι 

μεταβόλες στο πλάτος και στην περίοδο υπάρχουν και γιατί. 

Δημιουργία Project 
Βήμα 1

ο
:Πάμε στο File>New Project 

Βήμα 2ο:Επιλέγουμε File > Save Project As. Το παράθυρο διαλόγου Save As εμφανίζεται 

Βήμα 3ο:Επιλέγουμε τον φάκελο στον οποίο θέλουμε να αποθηκεύσουμε το Project. 

Βήμα 4ο:Δίνουμε μία ονομασία της επιλογής μας, π.χ. “DSB DEMOD” το νέο Project, στο 

παράθυρο διαλόγου που εμφανίζεται. Αποθηκεύουμε πατώντας Save. 

 

Ρύθμιση των καθολικών ρυθμίσεων και δημιουργία διαγράμματος 

συστήματος. 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του 

συστήματος. Για να  τις ορίσουμε κάνουμε τα εξής βήματα: 

• Από το οριζόντιο μενού επιλέγουμε Options> Project Options. 

• Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις 

αντιστοιχούν με αυτές που δίνονται παρακάτω. 

• Πατάμε ΟΚ για να αποθηκεύσουμε τις ρυθμίσεις. 
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Δημιουργία Διαγράμματος Συστήματος 

• Στο μενού Project, δεξί κλικ στο System Diagrams , επιλέγουμε την επιλογή New System 

Diagram.  

• Πληκτρολογούμε "DSB DEMOD" στο πεδίο κειμένου κι πατάμε το κουμπί «Create» 

ακριβώς από κάτω. 

 

• Για την δημιουργία της DSB αποδιαμόρφωσης  προσθέτουμε ακόμα 3 blocks στη 

διαμόρφωση της.  

o Προσθέτουμε ένα MULT. 

o Προσθετουμε ένα SINE. 

o Προσθέτουμε ένα φίλτρο LPFB. 

 

• Αφού αναπτύξουμε το Systems blocks, στην κατηγορία Sources επιλέγουμε την υπο-

ομαδα Waveforms. Στη συνέχεια επιλέγουμε το στοιχείο SINE και το τοποθετούμε στο 

διάγραμμα, σύροντάς το, προσθέτουμε με τον ίδιο τρόπο από το Math Tools το  MULT 

block και από τη κατηγορία Filters ,στην υπό-ομαδα Lowpass το φίλτρο LPFB block 

,όπως φαίνεται παρακάτω. 
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• Μετά πηγαίνουμε στο toolbar και πιέζουμε το Test Point button (=κουμπί). Το 

τοποθετούμε ανάμεσα στα SINE και στα MULT block που έχουμε βάλει στο διάγραμμα, 

ανάμεσα στα δύο MULT . Βάζουμε άλλο ένα Test Point με τον ίδιο τρόπο στην έξοδο 

του LPFB block. 

 

• Συνδέουμε τα blocks και τα test points όπως φαίνεται παρακάτω. Αυτό σημαίνει ότι 

μεταφέρεται σήμα από το ένα block (στοιχείο) στο άλλο. Η σύνδεση στοιχείου με 

στοιχείου γίνεται κάνοντας κλικ στην έξοδο του προηγούμενου και στη συνέχεια κλικ 

στην είσοδο του επόμενου. Ένα στοιχείο μπορεί να δίνει σήμα σε πάνω από ένα 

στοιχεία. 

 

• Κάνουμε διπλό click στο SINE block(ID A4). Βάζουμε "30" για τιμή του FRQ,’’0’’ για τιμή 

του CTRFRQ . 

 
 

• Κάνουμε διπλό click στο MULT block. Βάζουμε "Real domain" για τo CEMODE. 
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•  Κάνουμε διπλό click στο LPFB block. Βάζουμε "7" για τιμή του N,’’10’’ για τιμή του FP, 

όπως φένεται παρακάτω.  

 
 

4. Στο μενού Options επιλέγουμε Default System Options. Οι παράμετροι πρέπει να 

είναι όπως παρακάτω: 
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5. Στον Project Browser, κάνουμε δεξί click στα Graphs και μετά επιλέγουμε New 

Graph. Πληκτρολογούμε "DSB DEMOD" σαν όνομα και επιλέγουμε Rectangular σαν 

graph type. Μετά κάνουμε click στο Create. Όλα αυτά φαίνονται παρακάτω. 

 

• Στον Project Browser κάνουμε δεξί 

click στο "DSB DEMOD" και 

επιλέγουμε Add Measurement. 

•  Στο παράθυρο που θα ανοίξει, 

επιλέγουμε System σαν 

Measurement Type  

Επίσης επιλέγουμε TP.TP1 σαν Test Point, 

και Time Span = "1". Το Units πρέπει να 

είναι “ns”. Τέλος κάνουμε click στο OK 

για να αποθηκεύσουμε τις αλλαγές. Το 

ίδιο κάνουμε και για τα υπόλοιπα Test 

Point (TP.TP2, TP.TP3, TP.TP4). 
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Εκτέλεση Προσομοίωσης 
Μετά την επιτυχή υλοποίηση όλων των παραπάνω βημάτων, είμαστε πλέον έτοιμοι να 

θέσουμε σε λειτουργία την προσομοίωση του συστήματος. Για το σκοπό αυτό επιλέγουμε: 

Simulate > Run/Stop System Simulators. Αφήνουμε την προσομοίωση να τρέξει για 5 

δευτερόλεπτα και στη συνέχεια την διακόπτουμε με την επιλογή Simulate > Run/Stop 

Simulators. Το αποτέλεσμα της προσομοίωσης πρέπει να φαίνεται στο γράφημα όπως στην 

Εικόνα. 

 

Εικόνα – Αποτέλεσμα προσομοίωσης 

Λίστα Ελέγχου Γνώσεων 
1. Βεβαιωθείτε ότι έχετε κατανοήσει την αποδιαμόρφωση της DSB. 

2. Βεβαιωθείτε ότι μπορείτε να απεικονίσετε κυμματομορφές σε διάφορα σημεία του 

κυκλώματος.  

3. Βεβαιωθείτε ότι έχετε κατανοήσει τη σημασία των φίλτρων , τις 

παραμετροποιήσεις που απαιτόυν και πως αυτές επιδρούν στα αποτελέσματα της 

προσομοίωσης.  

Δραστηριότητες 

Απλές Δραστηριότητες 
1. Στο πείραμα της αποδιαμορφώσεως AM-DSB απεικονίσαμε 4 κυματομορφές 

στο ίδιο γράφημα. Καλείστε να δημιουργήσετε 4 διαφορετικά γραφήματα στο 

χώρο εργασίας, ένα για κάθε κυματομορφή. 

Προχωρημένες Δραστηριότητες 
1. Στο πείραμα που εκτελέστηκε σε αυτήν την άσκηση προσθέστε ένα επιπλέον 

γράφημα που να απεικονίζει το φάσμα του διαμορφωμένου σήματος καθώς και 

ένα για την ισχύ του. 

2. Στην διάταξη που χρησιμοποιήθηκε σε αυτήν την άσκηση εκτελέστε την 

προσομοίωση μεταβάλλοντας σταδιακά το πλάτος του φορέα. Τι συμπεραίνετε; 
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Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη -Χρήσιμοι 
σύνδεσμοι 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• https://awrcorp.com/download/faq/english/docs/Getting_Started/ 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• Freznel L. E. (1999), Ηλεκτρονικές Επικοινωνίες, Εκδόσεις Τζιόλα. 

• Hsu H. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα. 

• Σηµειώσεις Μαθήµατος Τηλεπικοινωνιών I, Ζαρούχας Θωμάς, Τσακανίκας 

Βασίλειος και Παρασκευάς Μιχάλης. 

• Εισαγωγή στα τηλεπικοινωνιακά συστήματα, Γ. Κοκκινάκης, 2004. 
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Άσκηση  4- AM-SSB ΔΙΑΜΟΡΦΩΣΗ (Μονοπλευρική 

διαμόρφωση) 

AM-SSB Διαμόρφωση - Στόχοι Εργαστηριακής Άσκησης 
Σκοπός τη άσκησης είναι να εξοικειωθούν οι σπουδαστές με την προσομοίωση 

διαμόρφωσης AM-SSB ακουστικού σήματος , έτσι ώστε να  μελετηθεί η διαμόρφωση 

πλάτους απλής ζώνης. 

Προσδοκώμενα αποτελέσματα 
Πιο συγκεκριμένα, μετά την εκτέλεση της παρούσης εργαστηριακής άσκησης οι φοιτητές θα 

πρέπει να: 

• Περιγράφουν την έννοια της διαμόρφωσης . 

• Να απεικονίζουν τα σήματα στο πεδίο του χρόνου  και στο πεδίο της συχνότητας. 

• Χρησιμοποιούν το AWR για τη προσομοίωση των διαφόρων τεχνικών διαμόρφωσης 

πλάτους 

• Παραμετροποιήσουν διάφορες μεταβλητές του περιβάλλοντος προσομοίωσης (π.χ. 

μονάδες μέτρησης κτλ.). 

• Εξάγουν γραφικές παραστάσεις από τις κυματομορφές που παράγονται. 

Τι θα χρειαστεί 
Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

• Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

Έννοιες κλειδιά 
• Αναλογική Διαμόρφωση 

• Διαμόρφωση κατά πλάτος 

• Σήμα 

• Συχνότητα 

 

Εισαγωγικές Παρατηρήσεις 
Οι μέθοδοι διαμόρφωσης πλάτους που εξετάσαμε έως τώρα απαιτούν εύρος ζώνης 

καναλιού διπλάσιο από το εύρος ζώνης του σήματος βασικής ζώνης. Αποδεικνύεται ότι η 

εκπομπή οποιασδήποτε από τις δύο πλευρικές ζώνες είναι αρκετή για να 

ανακατασκευασθεί το σήμα μηνύματος m(t) στο δέκτη. Με αυτό τον τρόπο μειώνουμε το 

εύρος ζώνης του εκπεμπόμενου σήματος στην τιμή του εύρους του σήματος βασικής ζώνης. 

 

Αν σε ένα DSB διαμορφωμένο από φέρον κυκλικής συχνότητας ωc (όπου ωc=2πfc) σήμα 

αποκόψουμε τη μία πλευρική ζώνη (για παράδειγμα την κάτω) και κατόπιν 

πολλαπλασιάσουμε με cosωct (όπου ωc=2πfc) θα παραχθεί ένα σήμα στη συχνότητα 2fc 

και η αρχική φασματική συνιστώσα στην αρχική συχνότητα του σήματος. Άρα προφανώς 

μπορούμε χρησιμοποιώντας μόνο τη μία πλευρική ζώνη να ανακτήσουμε το αρχικό μας 

σήμα. 

 



Τηλεπικοινωνιακά Συστήματα Ι                             Εργαστηριακός Οδηγός                                                 Διπλωματική Εργασία 

 

45 

 

Η αποδιαμόρφωση του SSB σήματος γίνεται με τον ίδιο τρόπο με αυτή της DSB-SC, δηλαδή 

απαιτείται στο δέκτη η δημιουργία σήματος με συχνότητα ίδια με αυτή του φέροντος. 

Προφανώς, η ύπαρξη απόκλισης στη γωνία (φάση ή συχνότητα) του δημιουργούμενου 

σήματος δημιουργεί και σε αυτή την περίπτωση παραμόρφωση στο ανακτημένο σήμα 

βασικής ζώνης. Συνεπώς και σε αυτή την περίπτωση πρέπει να βρεθούν παρόμοιες τεχνικές 

για το συντονισμό του πομπού με το δέκτη. 

Πείραμα: ΔΙΑΜΟΡΦΩΣΗ AM-SSB 
Σε αυτό το πείραμα φτιάχνουμε και κάνουμε εξομοίωση μια διαμόρφωση AM-SSB για τη 

μελέτη και την εξοικείωση με την τεχνική διαμόρφωσης πλάτους απλής ζώνης. Η 

δημιουργία του κυκλώματος θα γίνει με την μορφή δομικού διαγράμματος, με σκοπό την 

παρατήρηση της συμπεριφοράς του σήματος (πληροφορία) τόσο στο πεδίο του χρόνου, 

όσο και στο πεδίο των συχνοτήτων (φάσμα). 

 

Το πρόγραμμα στο τέλος θα χρησιμοποιεί: 

• Ένα σήμα πληροφορίας (στην προκειμένη περίπτωση 1 ημίτονο.  

• Ένα ημιτονικό σήμα ώς φέρον. 

Έναν πολλαπλασιαστή (Product) . 

• Ένα ζωνοδιαβατό φίλτρο (Bandpass filter). 

 

Οι διαδικασίες σε αυτό το παράδειγμα περιλαμβάνουν:  

• Έλεγχος της κυματομορφής του σήματος της πληροφορίας τόσο πριν 

πολλαπλασιαστεί με το φέρον, μετά τον πολλαπλασιασμό (δηλαδή μετά την 

διαμόρφωση), καθώς και μετά την έξοδο του ζωνοδιαβατού φίλτρου πάλι χρονικά 

και συχνοτικά.  

• Ρύθμιση του πλάτους με σκοπό την παρατήρηση στην αλλαγή του σήματος τόσο 

στο πλάτος αλλά και στην ισχύ στην οποία θα χρειαστεί να μεταδοθεί.  

• Εναλλαγή στις συχνότητες του φίλτρου με σκοπό να κόψουμε πότε την δεξιά 

πλευρική και πότε την αριστερή ανάλογα με το τι θέλουμε.  

Δημιουργία Project 
Βήμα 1

ο
: Πάμε στο File>New Project. 

Βήμα 2ο: Επιλέγουμε File > Save Project As. Το παράθυρο διαλόγου Save As 

εμφανίζεται. 

Βήμα 3ο: Επιλέγουμε τον φάκελο στον οποίο θέλουμε να αποθηκεύσουμε το Project. 

Βήμα 4ο: Δίνουμε μία ονομασία της επιλογής μας, π.χ. “SSB MOD” το νέο Project, στο 

παράθυρο διαλόγου που εμφανίζεται. Αποθηκεύουμε πατώντας Save. 

 

Ρύθμιση των καθολικών ρυθμίσεων και δημιουργία διαγράμματος 

συστήματος. 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του 

συστήματος. Για να  τις ορίσουμε κάνουμε τα εξής βήματα: 

• Από το οριζόντιο μενού επιλέγουμε Options> Project Options. 

• Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις 

αντιστοιχούν με αυτές που δίνονται παρακάτω. 

• Πατάμε ΟΚ για να αποθηκεύσουμε τις ρυθμίσεις. 
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Δημιουργία Διαγράμματος Συστήματος 

• Στο μενού Project, δεξί κλικ στο System Diagrams, επιλέγουμε την επιλογή New System 

Diagram. 

• Πληκτρολογούμε "SSB MOD" στο πεδίο κειμένου κι πατάμε το κουμπί «Create» όπως 

φένεται στο σχήμα. 

 

• Πηγαίνουμε στο Elements tab που βρίσκεται στα αριστερά. 

• Αφού αναπτύξουμε το Systems blocks, στην κατηγορία Sources επιλέγουμε την υπο-

ομαδα Waveforms. Στη συνέχεια επιλέγουμε δύο στοιχεία SINE και τα τοποθετούμε 

στο διάγραμμα, σύροντάς τα,(το ένα θα επιλέξουμε να είναι  Real Data). 

• Αφού αναπτύξουμε το Math Tools, επιλέγουμε το MULT και το τοποθετούμε στο 

διάγραμμα. 

• Τέλος, πρέπει να προσθέσουμε ένα Bandpass Filter όπως φένεται παρακάτω.Το BPFB 

block. 
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Μετά πηγαίνουμε στο toolbar και πιέζουμε το Test Point button (=κουμπί). Το τοποθετούμε 

ανάμεσα στα SINE και στο MULT block που έχουμε βάλει στο διάγραμμα,στο MULT και στο 

BPFB block. Βάζουμε άλλο ένα Test Point με τον ίδιο τρόπο στην έξοδο του BPFB block. 

Συνδέουμε τα blocks και τα test points όπως φαίνεται παρακάτω. Αυτό σημαίνει ότι 

μεταφέρεται σήμα από το ένα block (στοιχείο) στο άλλο. Η σύνδεση στοιχείου με στοιχείου 

γίνεται κάνοντας κλικ στην έξοδο του προηγούμενου και στη συνέχεια κλικ στην είσοδο του 

επόμενου. Ένα στοιχείο μπορεί να δίνει σήμα σε πάνω από ένα στοιχεία. 
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• Κάνουμε διπλό click στο SINE block(ID A1). Θέλουμε οι παραμετροποιήσεις να είναι 

όπως φαίνεται παρακάτω. 

 

• Κάνουμε διπλό click στο SINE block(ID A2). Βάζουμε "10" για τιμή του FRQ και ‘’ 0‘’ για 

τιμή του CTRFRQ , όπως φαίνεται παρακάτω. 

 

• Κάνουμε μετά διπλό click στο MULT και οι παράμετροι πρέπει να είναι όπως 

παρακάτω: 
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• Κάνουμε μετά διπλό click στο BPFB και οι παράμετροι πρέπει να είναι όπως 

παρακάτω: 

 

• Στο μενού Options επιλέγουμε Default System Options. Οι παράμετροι πρέπει να είναι 

όπως παρακάτω: 
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• Στον Project Browser, κάνουμε δεξί click στα Graphs και μετά επιλέγουμε New Graph. 

Πληκτρολογούμε "SSB MOD" σαν όνομα και επιλέγουμε Rectangular σαν graph type. 

Μετά κάνουμε click στο Create. Όλα αυτά φαίνονται παρακάτω. 

 

 

• Στον Project Browser κάνουμε δεξί click στο "SSB MOD" και επιλέγουμε Add 

Measurement.  

• Στο παράθυρο που θα ανοίξει, επιλέγουμε System σαν Measurement Type και WVFM 

σαν Measurement. 
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• Επίσης επιλέγουμε TP.TP1 σαν Test Point, και Time Span = "1". Το Units πρέπει να είναι 

Symbols. Τέλος κάνουμε click στο OK για να αποθηκεύσουμε τις αλλαγές. Το ίδιο 

κάνουμε και για τα υπόλοιπα Test Point (TP.TP2, TP.TP3, TP.TP4). 

Εκτέλεση Προσομοίωσης 
Μετά την επιτυχή υλοποίηση όλων των παραπάνω βημάτων, είμαστε πλέον έτοιμοι να 

θέσουμε σε λειτουργία την προσομοίωση του συστήματος. Για το σκοπό αυτό επιλέγουμε: 

Simulate > Run/Stop System Simulators. Αφήνουμε την προσομοίωση να τρέξει για 5 

δευτερόλεπτα και στη συνέχεια την διακόπτουμε με την επιλογή Simulate > Run/Stop 

Simulators. Το αποτέλεσμα της προσομοίωσης πρέπει να φαίνεται στο γράφημα όπως στην 

Εικόνα. 

 

Εικόνα– Αποτέλεσμα προσομοίωσης 

Λίστα Ελέγχου Γνώσεων 
1. Βεβαιωθείτε ότι έχετε κατανοήσει πως δημιουργούμε μια SSB διαμόρφωση. 

2. Βεβαιωθείτε ότι μπορείτε να απεικονίσετε κυμματομορφές σε διάφορα σημεία του 

κυκλώματος.  

Δραστηριότητες 

Απλές Δραστηριότητες 
1. Στο πείραμα της διαμορφώσεως AM-SSB απεικονίσαμε 3 κυματομορφές στο 

ίδιο γράφημα. Καλείστε να δημιουργήσετε 3 διαφορετικά γραφήματα στο χώρο 

εργασίας, ένα για κάθε κυματομορφή. 

Προχωρημένες Δραστηριότητες 
1. Στο πείραμα που εκτελέστηκε σε αυτήν την άσκηση προσθέστε ένα επιπλέον 

γράφημα που να απεικονίζει το φάσμα του διαμορφωμένου σήματος καθώς 

και ένα με την ισχύ του. 

2. Στην διάταξη που χρησιμοποιήθηκε σε αυτήν την άσκηση εκτελέστε την 

προσομοίωση μεταβάλλοντας σταδιακά το πλάτος του φορέα. Τι συμπεραίνετε; 
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Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη -Χρήσιμοι 
σύνδεσμοι 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• https://awrcorp.com/download/faq/english/docs/Getting_Started/ 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• Freznel L. E. (1999), Ηλεκτρονικές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Hsu H. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Σηµειώσεις Μαθήµατος Τηλεπικοινωνιών I, Ζαρούχας Θωμάς, Τσακανίκας 

Βασίλειος και Παρασκευάς Μιχάλης. 

• Εισαγωγή στα τηλεπικοινωνιακά συστήματα, Γ. Κοκκινάκης, 2004.  
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Άσκηση  5- AM-SSB ΑΠΟΔΙΑΜΟΡΦΩΣΗ 
 

AM-SSB Αποδιαμόρφωση - Στόχοι Εργαστηριακής Άσκησης 
Σκοπός τη άσκησης είναι να εξοικειωθούν οι σπουδαστές με την προσομοίωση αποδιαμόρφωσης AM-

SSB ακουστικού σήματος , έτσι ώστε να μελετηθεί το λαμβανόμενο σήμα τόσο χρονικά, όσο και 

φασματικά.  

Προσδοκώμενα αποτελέσματα 
Πιο συγκεκριμένα, μετά την εκτέλεση της παρούσης εργαστηριακής άσκησης οι φοιτητές θα πρέπει να: 

• Περιγράφουν την έννοια της διαμόρφωσης . 

• Να απεικονίζουν τα σήματα στο πεδίο του χρόνου  και στο πεδίο της συχνότητας. 

• Χρησιμοποιούν το AWR για τη προσομοίωση των διαφόρων τεχνικών διαμόρφωσης πλάτους. 

• Παραμετροποιήσουν διάφορες μεταβλητές του περιβάλλοντος προσομοίωσης (π.χ. μονάδες 

μέτρησης κτλ.). 

• Εξάγουν γραφικές παραστάσεις από τις κυματομορφές που παράγονται. 

Τι θα χρειαστεί 
Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

• Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

Έννοιες κλειδιά 
• Αναλογική Διαμόρφωση 

• Διαμόρφωση κατά πλάτος 

• Σήμα 

• Συχνότητα 

 

Εισαγωγικές  Παρατηρήσεις 
 

Η λήψη και η αποδιαμόρφωση ενός σήματος αποτελεί την αντίστροφη διαδικασία της διαμόρφωσης 

και της εκπομπής. Συνεπώς, η τηλεπικοινωνιακή αλυσίδα που περιγράφτηκε στις προηγούμενες 

εργαστηριακές ασκήσεις αντιστρέφεται στην πλευρά του δέκτη μέχρι την ανακατασκευή του 

ακουστικού σήματος. 

Πείραμα: ΑΠΟΔΙΑΜΟΡΦΩΣΗ AM-SSB 
Σε αυτό το πείραμα φτιάχνουμε και κάνουμε εξομοίωση μιας αποδιαμόρφωση AM-SSB ,αντίστοιχα για 

να τη μελετούμε με σκοπό την παρατήρηση του λαμβανόμενου σήματος τόσο χρονικά, όσο και 

φασματικά. 
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Το πρόγραμμα στο τέλος θα χρησιμοποιεί: 

• Ένα σήμα πληροφορίας (στην προκειμένη περίπτωση 1 ημίτονο.  

• Ένα ημιτονικό σήμα ώς φέρον. 

• Έναν πολλαπλασιαστή (Product) . 

• Ένα lowpass filter (χαμηλοδιαβατό φίλτρο). 

 

Οι διαδικασίες σε αυτό το παράδειγμα περιλαμβάνουν:  

• Έλεγχος της κυματομορφής του σήματος της πληροφορίας μετά την διαμόρφωση, μετά τον 

πολλαπλασιασμό πάλι με το φέρον, καθώς και μετά το χαμηλοδιαβατό φίλτρο.  

• Ρύθμιση του πλάτους με σκοπό την παρατήρηση στην αλλαγή του σήματος τόσο στο πλάτος 

αλλά και στην ισχύ στην οποία θα χρειαστεί να μεταδοθεί.  

• Παρατήρηση του τι συμβαίνει, με την αλλαγή φάσης στο τελικό σήμα, καθώς και τι μεταβόλες 

στο πλάτος και στην περίοδο υπάρχουν και γιατί. 

Δημιουργία Project 
Βήμα 1

ο
: Πάμε στο File>New Project 

Βήμα 2ο: Επιλέγουμε File > Save Project As. Το παράθυρο διαλόγου Save As εμφανίζεται 

Βήμα 3ο: Επιλέγουμε τον φάκελο στον οποίο θέλουμε να αποθηκεύσουμε το Project. 

Βήμα 4ο: Δίνουμε μία ονομασία της επιλογής μας, π.χ. “SSB DEMOD” το νέο Project, στο 

παράθυρο διαλόγου που εμφανίζεται. Αποθηκεύουμε πατώντας Save. 

Ρύθμιση των καθολικών ρυθμίσεων και δημιουργία διαγράμματος 

συστήματος. 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του συστήματος. 

Για να  τις ορίσουμε κάνουμε τα εξής βήματα: 

• Από το οριζόντιο μενού επιλέγουμε Options> Project Options 

• Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις αντιστοιχούν με 

αυτές που δίνονται παρακάτω 

• Πατάμε ΟΚ για να αποθηκεύσουμε τις ρυθμίσεις. 
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Δημιουργία Διαγράμματος Συστήματος 

• Στο μενού Project, δεξί κλικ στο System Diagrams , επιλέγουμε την επιλογή New System Diagram.  

• Πληκτρολογούμε "SSB DEMOD" στο πεδίο κειμένου κι πατάμε το κουμπί «Create» ακριβώς από 

κάτω. 

 

• Για την δημιουργία της SSB αποδιαμόρφωσης  προσθέτουμε ακόμα 3 blocks στη διαμόρφωση της.  

o Προσθέτουμε ένα MULT. 

o Προσθετουμε ένα SINE. 

o Προσθέτουμε ένα φίλτρο LPFB. 

 

• Αφού αναπτύξουμε το Systems blocks, στην κατηγορία Sources επιλέγουμε την υπο-ομαδα 

Waveforms. Στη συνέχεια επιλέγουμε το στοιχείο SINE και το τοποθετούμε στο διάγραμμα, 

σύροντάς το, προσθέτουμε με τον ίδιο τρόπο από το Math Tools το  MULT block και από τη 

κατηγορία Filters ,στην υπό-ομαδα Lowpass το φίλτρο LPFB block ,όπως φαίνεται παρακάτω. 
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• Μετά πηγαίνουμε στο toolbar και πιέζουμε το Test Point button (=κουμπί). Το τοποθετούμε 

ανάμεσα στα SINE και στα MULT block που έχουμε βάλει στο διάγραμμα, ανάμεσα στο MULT και 

BPFB block. Βάζουμε άλλο ένα Test Point με τον ίδιο τρόπο στην έξοδο του LPFB block. 

 

• Συνδέουμε τα blocks και τα test points όπως φαίνεται παρακάτω. Αυτό σημαίνει ότι μεταφέρεται 

σήμα από το ένα block (στοιχείο) στο άλλο. Η σύνδεση στοιχείου με στοιχείου γίνεται κάνοντας κλικ 

στην έξοδο του προηγούμενου και στη συνέχεια κλικ στην είσοδο του επόμενου. Ένα στοιχείο 

μπορεί να δίνει σήμα σε πάνω από ένα στοιχεία. 
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• Κάνουμε διπλό click στο SINE block(ID A4). Βάζουμε "10" για τιμή του FRQ,’’0’’ για τιμή του 

CTRFRQ . 

 
 

 

• Κάνουμε διπλό click στο MULT block. Βάζουμε "Real domain" για τo CEMODE. 
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•  Κάνουμε διπλό click στο LPFB block. Βάζουμε "7" για τιμή του N,’’10’’ για τιμή του FP, όπως 

φένεται παρακάτω.  

 
 

6. Στο μενού Options επιλέγουμε Default System Options. Οι παράμετροι πρέπει να είναι όπως 

παρακάτω: 
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7. Στον Project Browser, κάνουμε δεξί click στα Graphs και μετά επιλέγουμε New Graph. 

Πληκτρολογούμε "SSB DEMOD" σαν όνομα και επιλέγουμε Rectangular σαν graph type. Μετά 

κάνουμε click στο Create.  

 

• Στον Project Browser κάνουμε δεξί click στο "SSB DEMOD" και επιλέγουμε Add Measurement. 

•  Στο παράθυρο που θα ανοίξει, επιλέγουμε System σαν Measurement Type. 

 

Επίσης επιλέγουμε TP.TP1 σαν Test Point, και Time Span = "1". Το Units πρέπει να είναι”ns”. Τέλος 

κάνουμε click στο OK για να αποθηκεύσουμε τις αλλαγές. Το ίδιο κάνουμε και για τα υπόλοιπα Test 

Point (TP.TP2, TP.TP3, TP.TP4). 
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Εκτέλεση Προσομοίωσης 
Μετά την επιτυχή υλοποίηση όλων των παραπάνω βημάτων, είμαστε πλέον έτοιμοι να θέσουμε σε 

λειτουργία την προσομοίωση του συστήματος. Για το σκοπό αυτό επιλέγουμε: 

Simulate > Run/Stop System Simulators. Αφήνουμε την προσομοίωση να τρέξει για 5 δευτερόλεπτα και 

στη συνέχεια την διακόπτουμε με την επιλογή Simulate > Run/Stop Simulators. Το αποτέλεσμα της 

προσομοίωσης πρέπει να φαίνεται στο γράφημα όπως στην Εικόνα. 

 

Εικόνα – Αποτέλεσμα προσομοίωσης 

Λίστα Ελέγχου Γνώσεων 
1. Βεβαιωθείτε ότι έχετε κατανοήσει την αποδιαμόρφωση της AM-SSB.  

2. Βεβαιωθείτε ότι μπορείτε να απεικονίσετε κυμματομορφές σε διάφορα σημεία του 

κυκλώματος.  

3. Βεβαιωθείτε ότι έχετε κατανοήσει τη σημασία των καθολικών παραμέτρων του συστήματος και 

πως αυτές επιδρούν στα αποτελέσματα της προσομοίωσης.  

Δραστηριότητες 

Απλές Δραστηριότητες 
1. Καλείστε να μελετήσετε το γραφικό περιβάλλον και να εντοπίσετε τις διάφορες συντομεύσεις 

εκτελώντας ξανά το πείραμα της διαμορφώσεως AM. 

2. Στο πείραμα της αποδιαμορφώσεως AM-SSB απεικονίσαμε 4 κυματομορφές στο ίδιο γράφημα. 

Καλείστε να δημιουργήσετε 4 διαφορετικά γραφήματα στο χώρο εργασίας, ένα για κάθε 

κυματομορφή. 

Προχωρημένες Δραστηριότητες 
1. Στο πείραμα που εκτελέστηκε σε αυτήν την άσκηση προσθέστε ένα επιπλέον γράφημα που να 

απεικονίζει το φάσμα του διαμορφωμένου σήματος καθώς και ένα με την ισχύ του. 
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2. Στην διάταξη που χρησιμοποιήθηκε σε αυτήν την άσκηση εκτελέστε την προσομοίωση 

μεταβάλλοντας σταδιακά το πλάτος του φορέα. Τι συμπεραίνετε; 

 

Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη -Χρήσιμοι 
σύνδεσμοι 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• https://awrcorp.com/download/faq/english/docs/Getting_Started/ 

• https://en.wikipedia.org/wiki/Amplitude_modulation 

• Freznel L. E. (1999), Ηλεκτρονικές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Hsu H. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα 

• Σηµειώσεις Μαθήµατος Τηλεπικοινωνιών I, Ζαρούχας Θωμάς, Τσακανίκας Βασίλειος και 

Παρασκευάς Μιχάλης. 

• Εισαγωγή στα τηλεπικοινωνιακά συστήματα, Γ. Κοκκινάκης, 2004. 

 

 

Τελικά Συμπεράσματα 
Παρατηρούμε πως  για την ίδια διαθέσιμη τελική ισχύ εκπομπής, η αποτελεσματικότητα των 

διαμορφώσεων έχει ως εξής:  

• SSBsc 

• DSBsc 

• AM 

διοτί η διαθέσιμη τελική ισχύ εκπομπής στην SSBsc πάει όλη στο κομμάτι που μεταφέρει την 

πληροφορία, στην DSBsc ναι μεν πάει στο κομμάτι που πάει στην πληροφορία αλλά έχουμε δύο ζώνες 

στο φάσμα άρα πλεονασμό και στην ΑΜ σπαταλιέται έξτρα ισχύς και για το φέρον. Αυτό φαίνεται 

ξεκάθαρα και από τα διαγράμματα του φάσματος και της ισχύος.  

 

Παρόλα αυτά μπορεί να «γλυτώνουμε» αρκετά με την SSBsc σε θέμα ισχύος, αλλά χάνουμε γιατί το 

κύκλωμα που θα πρέπει να δημιουργήσουμε είναι αρκετά μεγαλύτερο και πιο απαιτητικό στον 

σχεδιασμό του. Σαν αποτέλεσμα θα πρέπει ανάλογα με την περίπτωση και το τι χρειαζόμαστε να 

διαλέξουμε την βέλτιστη διαμόρφωση ώστε να έχουμε την σωστή αναλογία σε θέμα ισχύος-

σχεδιασμού κυκλώματος.  

 

Παρατηρούμε επίσης πώς όσο περισσότερο πλάτος έχουμε στην πληροφορία μας, αυτό έχει 

επιπτώσεις και στο πλάτος του διαμορφωμένου σήματος μας με αποτέλεσμα να χρειαζόμαστε και 

μεγαλύτερη ισχύ εκπομπής.  

 

Μια ακόμα χρήσιμη παρατήρηση είναι πως ποσοστό διαμόρφωσης έχουμε μόνο στην ΑΜ. Επομένως 

με την ΑΜ μπορούμε να διαλέξουμε με τι ποσοστό διαμόρφωσης μπορούμε να στείλουμε την 

πληροφορία μας. Σε περίπτωση που η πληροφορία μας είναι απλή μπορούμε να χρησιμοποιήσουμε 

ένα σχετικά χαμηλό ποσοστό διαμόρφωσης έτσι ώστε να γλυτώσουμε αρκετή ενέργεια. 


